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This Month’s April Meetings 
General Meeting 

Now Tuesday, May 8 at 6:00 P.M. 
At Christ Lutheran Church FFG 

 
Photo Editing Workshop 

Thursday, May 10 at 1:00 P.M. 
At FFG Library Bldg. 

 
Plateau Photography Club 

Thursday May 17 at 1:00 P.M.  
At FFG Library Bldg. 
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The May Program at  
FFG Christ Lutheran Church 

 

Google Photos 
 
This month’s Meeting will be an “apcug” video 
presentation on “Google Photos” by Ron Brown, 
who is Program Director at a computer club in 
Mesa Arizona.   
 
He will explain a brief history on cameras and 
pictures and how to save and sort through thou-
sands of photos using Google Photos.  
 
This is a service to organize and store photos in 
the cloud and it is FREE. At 
www.photo.google.com.  
 
It is like a shoebox full of photos but you can eas-
ily find a specific photo. Since we now take most 
of our photos with our phone, it is designed for 
mobile first but can also be used with your Tablet, 
Laptop and desktop computer. It’s easy-to-use, 
with unlimited storage. 
 
Ron will demonstrate many of the program fea-
tures throughout this YouTube video. 
. 

Winter Hours  star t at 3:00 P.M. (October though March) 
Summer Hours star t at 6:00 P.M. (Apr il through September) 
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade 
 

NOTE:  Meeting Dates are now on 2nd Tuesday’s of the month  

Mother’s Day Sunday, May 13, 2018 

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of the 
SIG meetings as a guest will be charged $3.00 per person for 
any or all meetings in that month. Afterwards, you are en-
couraged to become a member of the Plateau PC Users 
Group.  
Our Club cannot exist without you, the members.  
  
Membership Dues  

Our annual dues are now payable July 1st of each year.   
Annual dues are $24 per single person / $30 per family  
starting July 1, 2014.with partial years dues as follows: 

  
 
 

 
 
 
 
 
 
 

Student memberships (21 and under) are $10 annually.   
Corporate memberships are $30 a year for the first two  
memberships and $10  a year for each additional  
membership from the same company.   
Contact the PPCUG Treasurer (931) 707-3677  
for pro-rated dues of these types of memberships. 
 

BOARD OF DIRECTORS DISCLAIMER 
 

All members of the Plateau PC Users Group are willing to 
help one another in the area of advice and tutorial instruc-
tion over the phone.  If you should require more involved 
services or instruction, we have a few members who are 
very knowledgeable in several areas.  As a responsible  
consumer, it is up to you to discuss, before retaining a mem-
ber, any and ALL charges for repair services and time con-
suming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees for 
individuals for services rendered, nor the responsibility to 
intervene between members who enter into a contract 
among themselves. 
 
The GAZETTE is published using the following:  Microsoft 
Word, Microsoft Publisher, and Microsoft Windows.  The 
Gazette is the monthly newsletter of the Plateau PC Users 
Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is made 
by the PPCUG, the Gazette editorial staff or its contributing 
editors.  This extends to all losses incidental or consequen-
tial from the use or non-use of any information in any issue 
of the Gazette. 
 
All images used in the newsletter, website, blogs, class mate-
rials or handouts (“media”)  are obtained from a “free use” 
source, preferably images that have been released as “CCO 
Public Domain”. 

 
2017-2018 PPCUG, Inc. Board Members 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Secretary Cindy West (931) 484-7306 

Past President Carl Nordeen  (931) 456-5597 

Programs Open  

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 788-2201 

   

Directors at Large 

Alan Baker Gordon Botting Richard Del Frate 

Barbara Duncan Bob Willis  

   

Director Emeritus 
Don Lewis  

    

 SIG Leaders   

Plateau Photography 
Club 

Jim Mansfield (931) 484-6920 

Photo Editing  
Workshop Club 

Jim Gries FGPhotowork-
shop@gmail.com 
(331) 442-9763 

 
Due Date 

Apr-Jun 
2018 

Jul-Sep 
2018 

Annual Dues 

Oct—Dec 
2018 

Jan-Mar 
2019 

Single: $6 $24 $18 $12 

Families: 
$7 $30 $22 $22 
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Up Coming Meeting for June 2018 
 

Note: Summer Hours & Location & Date 
 

The next General Meeting of the 
PLATEAU PC USERS GROUP 

Will be on Tuesday, June 12 at 6:00 P.M. 
at Christ  Lutheran Church 

481 Snead Drive FFG 
(corner of Snead & Lakeview Drive) 

 

Classes  
Please send ideas for new classes to Alan Baker.  

( ambaker@citlink.net ) 

 
 

 

 
News of the Special Interest Groups 

 
The PPCUG sponsors several Special Interest Groups 
(SIGs) tailored to meet the varied needs of our many 
members.  Each SIG is a small group whose leader 
prepares material for presentation and encourages 
open discussion and questions.  We urge you to attend 
the SIGs and hope you will find one or more of inter-
est to you.  Ideas for additional groups are welcome, 
as are volunteers to form and lead new SIGs. 
 

Plateau Photography Clubs 
 
The Photo Editing Workshop Club is held at 1:00 PM 
at the Fairfield Glade Library Bldg. on the Second 
Thursday of each month.  Members meet to discuss & 
demonstrate various editing software programs avail-
able to enhance their photographs. The SIG leader is 
Jim Gries. at “FGPhotoworkshop@gmail.com” 
 
 
 
 
The Photography Club, a PPCUG SIG, meets the 
Third Thursday of each month at the Fairfield Glade 
Library Bldg. at 1:00PM.  Topics vary each month 
but we show and discuss member's photos each 
month.  The SIG leader is Jim Mansfield.  
 
 

The Photo Club/SIG website 
 
The Photo Club/SIG website is now up.  Access 
to it is through the PPCUG website, using the "Photo 
Club" navigation link at the top of each PPCUG 
page.  I think that this is a big improvement, and 
could not have been done without the work of  
Dallas Richards. 
 
 

 

 PPCUG Website 
 

Visit our website at www.PPCUGinc.com. The 
Learning Center class schedule and Gazette are 
all available on our web site. 
 
Send your comments and suggestions to the  
Webmaster, Alan Baker 
Webmaster@ppcuginc.com  (931) 788-2201 

Cool Tips & Sites 

Getting free information on your phone 

Updated: 04/26/2017 by Computer Hope 

 

 
Each time you dial 411 for information, your 
phone bill is automatically charged. Instead, try 
using a free service like ChaCha: 1-800-
2CHACHA, which allows you to ask any  
question imaginable and have the answer texted 
back to you at no charge.  
 
Another resource is Free 411: 1-800-FREE-411, 
which sends free information as well as things like 
the latest news, stock quotes, movies, etc. 
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Vote for PPCUG Officers Election in June 2018 

  

(For the period July 2018 though June 2019) 
  

Candidates slated for PPCUG Board include: 
  
President: Steve Rosenstein 
Vice President & Compliance: Jim Buxton 
Treasurer: John Krueger 
Secretary: Cindy West 
Past President: Carl Nordeen 
  
Directors at Large:  
  Alan Baker 
 Gordon Botting   
 Barbara Duncan 
  Richard Del Frate 
  Bob Willis    

********************** 

Run Windows System Maintenance 

Windows 10 has a built-in maintenance utility that can help find and fix issues in the operating system.  
It can also identify and run processes that can help improve computer performance. 
To access and use the Windows System Maintenance utility, follow the steps below. 
1. In the Search Windows text box, next to the Start button on the taskbar, type system maintenance, 

then press Enter. 
2. In the Security and Maintenance window, click the Troubleshooting link towards the bottom of the 

window. 
3. In the Troubleshooting window, under the System and security section, click the Run maintenance 

tasks link. 
4. Click the Next button to run the Troubleshooter utility. If a message appears saying to run the Trou-

bleshooter as an administrator, click the Try troubleshooting as an administrator option. 
 

 
 

5. If any errors or issues are found, or any suggestions are provided, follow the steps to fix the errors 
and issues, and implement the suggestions. 

Tuesday, June  12th Meeting 
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Looking Back to See Ahead 
 

By Greg Skalka, President, Under the Computer Hood User Group, CA 
January 2018 issue, Drive Light 
www.uchug.org 
president (at) uchug.org 
 
Another year goes into the record books, and we get a new, clean slate ahead. As we say good-bye to 2017 and 
prepare to start writing 2018 on our checks (hey, wait a minute; who writes checks these days, anyway?), we are 
confronted by this arbitrary boundary in time once again. 
 
It is obvious the year and its length are derived from our Earth’s orbit around the sun. But why set the boundary 
for a year in the winter? Wouldn’t all those people in Times Square have a much better New Year’s Eve in the 
spring, summer or even autumn?  Our January 1 is not even tied to any astronomical event, like an equinox or 
solstice. 
 
Ancient civilizations celebrated the New Year at different times with respect to the seasons. Mesopotamians had 
their new year’s rockin eve (no doubt with real stones) in the spring, around the vernal equinox. The autumnal 
equinox was when ancient Egyptians and Persians celebrated their new year. The ancient Greeks began their 
new year around December 20, the winter solstice. 
 
So why do we believe the New Year starts on January 1st? It seems we can blame it on the Romans. Among the 
many things, we still use that are carried over from the Roman Empire, including aqueducts, roads and a numer-
ical system that we use to count our Super Bowls, is the Julian calendar. That calendar begins with the month of 
January, named for the Roman god of doorways and beginnings, Janus; his feast begins the New Year.  
 
Janus is depicted as having two faces, one looking back in time and one looking forward into the future. Around 
this time of year there are often predictions made for the New Year. I’ve written columns in the past for this 
month, trying to prognosticate on what is to come in the tech world, mostly with little success. Bill Gates was 
probably right when he said, “We always overestimate the change that will occur in the next two years and un-
derestimate the change that will occur in the next ten.”  I keep thinking something monumental will happen in 
tech in the next few years, but it rarely does, yet in 2007 few people could have seen imagined the impact the 
iPhone, Facebook, Twitter, Airbnb, IBM’s Watson and fracking would have on our lives today. Perhaps by 
viewing the world like Janus, and first looking back on the past year, can be a better picture of what is to come 
in 2018. 
 
We all look at the world through unique eyes, with our perceptions filtered by our own personalities and experi-
ences. I’m heavily involved in technology on a daily basis, being an electrical engineer presently designing  
digital communications equipment. I read quite a bit about the latest innovations, yet I would not consider my-
self an “early adopter.” Part of this may be due to my age; I’m part of the tail end of the baby boomer demo-
graphic. I may have a lot more money for technology, but I don’t necessarily buy into it (or some of the societal 
change that often go with it) as much as my millennial children. I also look more at anything I’m buying as a 
value proposition. Cutting-edge technology may be really nice, but it usually costs a lot more when it is the  
latest and greatest. I prefer to wait a bit until the costs are lower, the capabilities are more proven, and the  
pitfalls are uncovered. I also prefer the devices that emphasize capability over cachet; I don’t need a fruit on my 
device solely for the sake of status. 
 
For me, 2017 was a year of increased connectivity. I bought my first smartphone in June, after moving into the 
world of SMS text communication with a flip phone only the year before. I’ve accelerated my longtime interest 

(Continued on page 6) 
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in home automation, adding many more Smart Home tech items. I’ve taken advantage of faster internet connec-
tions to stream more content, and have found a greater need to use and improve my home Wi-Fi setup. I find I’m 
more often using more Android and Chrome OS devices, and fewer Windows devices for my connections. 
 
Getting a smartphone is no doubt the biggest tech change in my life in the last year, and it has been an enabler 
for additional tech. I was the last in my family of four to get one, in spite of being the one that paid for them all 
(or, perhaps because I was the one paying for them all). When I was finally able to be happy with the value I 
was getting, my new Samsung Galaxy J3 Prime Android phone (a new but lower cost model) joined the iPhones 
and Google Nexus phone on the family phone plan in June. It is great to be able to get information from the  
internet (practically) wherever you are. I text a lot more than call, while purposely not using the phone much for 
email. I find I’m using my Magellan vehicle GPS a lot less now, and the Google maps app a lot more when  
driving. My phone’s camera is pretty good but not fantastic; while most of the pictures on this year’s family 
photo Christmas card were taken by phones (selfies), I’m not giving up on digital cameras. When my good  
digital camera broke this year, I found out how poor a substitute the phone was for all but basic photography, 
and so got a replacement camera. My 2017 eclipse photos with the digital camera were great, while the phone 
photos of the event were a bust. 
 
Yet my adoption of the smartphone into my life is a cautious and measured change. Karl Marx may have felt 
that religion was the opiate of the masses, but he never got to see how people’s behavior has changed as a result 
of constant connectedness and social media. I believe smartphones and Facebook are the new opiates of the 
masses, and I don’t want to be among the addicted. Last night at Phil’s BBQ, my wife again commented to me 
on how many people (and not just children) were paying more attention to their screens than their families at 
dinner. Driver’s laps are not supposed to glow; far too many concentrate on their devices, rather than the road. 
I’ll use my phone for navigation when driving, but will always pull over to read a text or answer a call. 
 
I’ve fortunately never become obsessed with social media. While I can see how, when used in moderation,  
Facebook can be useful to keep in touch with family and friends, its overuse can be a problem. I don’t have a 
Facebook account, but I’ve seen the excessive postings of others on my wife’s account. They remind me of a 
favorite engineering “law.” The more time you spend reporting on what you are doing, the less time you have to 
do anything. Stability is achieved when you are spending all your time reporting on the nothing you are doing. 
Just substitute posting for reporting, and you’ll see where I’m going. 
 
My wife does more watching on Facebook than posting, but still posts more that I think is necessary, especially 
when we are away on vacation. It is frustrating to return to work after a weekend trip with your wife, and not be 
able to tell anyone about your adventures, as your coworkers have already been told by their wives about the 
posts your wife made on Facebook while you were away (including photos). 
 
We have also increased our Smart Home connectedness this year. We bought an Amazon Echo Dot voice-
operated assistant device for our home in late 2016, and bought a second this spring for upstairs. We now have a 
few light controllers and a smart thermostat that are Alexa-compatible. I even bought a Google Home Mini  
during the Black Friday sale, so we could see what the competing device offers. The three networked, Wi-Fi  
security cameras I bought this year allowed us to watch over our home while away on vacation, and I’ve pur-
chased a couple for outdoor security use as well. My new smartphone of course allows me to view the cameras, 
control the lights and adjust the heating while away (or just in the recliner).  
 
One problem with all this connectedness is maintaining all the connections. I have always been suspicious of  
Wi-Fi as a secure means of networking, preferring wired Ethernet. With all these new IoT Wi-Fi devices, our 
poor little Wi-Fi access point has become inadequate. To get the range required to put these new cameras and 
other devices anywhere in the house I want, I’ve had to look at changing to a mesh Wi-Fi network. It seems that 
all this tech feeds on itself, creating more issues that require new technology for the solutions. 
 

(Continued from page 5) 

(Continued on page 7) 
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So, considering where I’ve been this last year, can I get any insight into where at least I’ll be going with technol-
ogy in the coming year? Probably more of the same, but at an increased level. I doubt self-driving cars will be 
available this year, but I won’t be buying one if they are. They will be new and have insufficient value for their 
cost. Maybe in 5-10 years, though. 
 
Will I buy a new iPhone? Not when I could have had six of the Samsung phones I bought for the cost of the re-
placement iPhone I bought for my wife this fall. Will I get rid of my Magellan car GPS?  Maybe. Although it 
was useful on our eclipse trip to Nebraska (when Google Maps could not navigate due to the lack of a good cell 
connection in rural areas), it could probably be replaced by an app on my phone. Will I get rid of my digital  
camera? No, the phone camera is not good enough yet. Will I take more phone photos? Yes, it is way too con-
venient, and with me most of the time. Will I get Facebook or Twitter accounts? No, still not interested. Will I 
book an Uber or Lyft ride in 2018? Maybe, since I now have a smartphone. I’ve been part of a few group rides 
booked by others, and it seems convenient. 
 
Since Windows 7 extended support ends in January 2019, I’ll probably start worrying about what to do about our 
four Win7 computers later on this year. Perhaps Microsoft will extend security support. Perhaps I’ll just take 
them off my network, like I’ve done with my XP machine. Perhaps I won’t care, as I’m using Windows for  
fewer computer activities anyway. I’ll be buying TurboTax to file my 2017 taxes, but my 2018 tax filing may be 
a lot simpler, though costlier. 
 
 

Getting Started with Microsoft OneNote 

By Joana Simoes 

 

You’ve probably seen Microsoft OneNote among your Microsoft Office programs, but maybe you ignored it  
because you assumed that it was a program mainly for students. While it is quite popular with students to  
organize their class notes, you too can use OneNote to get organized. It’s a versatile program that can bring  
coordination into your personal and professional life. 

Get Organized with Microsoft OneNote 
OneNote is basically a system where you create different virtual notebooks. You can then break down the note-
books into different sections. To get started, open up Microsoft OneNote. It will ask you to give the notebook a 
name. Name it and then click on Create Notebook. 
 

 

(Continued from page 6) 

(Continued on page 8) 
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When you create the notebook, OneNote will ask you if you would like to invite other people to view it. This 
option is helpful if you’re working on a team project, or even just household items you’d like to share with  
family members. 
 

 

 
Now your notebook is created. Microsoft OneNote works with a hierarchical system of organization that is 
made up of notebooks, sections, and pages. 

 Notebooks are the main par t of the system. 
 Sections are the dividers within the notebook. 
 Pages can fur ther  break down the sections. 

Let’s use a shopping list notebook as an example of how to break things down within the OneNote system.  
Create a shopping list notebook and then create different sections within it. The different sections are the tabs 
you find on the top. By clicking on the plus tab you can add a different section to your notebook, and even color 
code them. 
 

 

 
Within the sections, you can create new pages. On the right-hand side, you will find a section that will say  
Add Page. For instance, within the groceries section, I began to break it down by Meat and Fish, or Vegetables 
& Fruit. Now, this is really just to show you how OneNote can be used, and how its system is broken down. 
 

 

(Continued from page 7) 
 

(Continued on page 9) 
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One Notebook or Multiple Notebooks? 
OneNote can very simply be used with one notebook and then you use the sections to break it all down into  
different topics. It’s a program that really allows you to customize your organization. By creating different 
notebooks you can have a better system of organization. Plus this way you can really keep the personal and the  
professional separated, and have the option to share notebooks with others without sharing your personal 
things. 
 

 

 
OneNote was originally started as a tool for students, but it has grown into a tool that anyone can use for  
organizing their daily lives.  
 

(Continued from page 8) 
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How to Recover Microsoft Office Excel, Word or PowerPoint Files 

By Joana Simoes 

The frustration of losing work to a computer crash is possibly one of the most disheartening feelings a profes-
sional can get hit with. Luckily technology has advanced in a way that has lessened the chance of losing work. 
Microsoft Word, Excel, and PowerPoint, for example, allow you to both repair your documents and spread-
sheets as well as automatically take backups of your  un-saved documents. Let’s review the feature as well as 
where you can find your lost work after a crash! 

Recovering Word Documents 
Microsoft Word is one of the most widely used programs within Office. So whether you’re a professional who 
needs their work back or a student desperately trying to recover their 10-page paper, it’s a lot easier to recover 
files with the last several versions of Microsoft Office 2016. 

Open Word, Go to File > Open and Click the Recover Unsaved Documents button. 

 

 

This should have your document in a folder ready to open. Typically with the newer versions of Word, when 
you restart from a crash the office program will actually ask you if you want to open unsaved documents. 
 
Recovering Excel Workbooks and PowerPoint Presentations 
The great thing about the current version of Microsoft Office is that the options are all very similar with slight 
differences for certain features and aspects, but recovering a document is the same process no matter what  
program you use. So whether you’re in Word, Excel, or PowerPoint the steps are the same, the names of the 
documents are different. In Excel, it’s a Workbook and in PowerPoint, it’s a presentation. 
 

 

 
 
 
 

(Continued on page 11) 
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AutoRecover 

Although enabled by default, I recommend everyone confirm AutoRecover is enabled and creating backups so 
you don’t have to take any extreme measures to recover your unsaved files in case of a computer crash or unex-
pected restart. To do this go to File > Options > Save and make sure that you check the box next to where it 
says Save AutoRecover information every 10 minutes. The default setting here is 10 minutes, however, feel 
free to change this to whatever you personally prefer. For me, 5 minutes is good enough to ensure that my files 
will be there after a crash. 

 

 

How to Use Quick Parts in Microsoft Outlook 2016 

By Joana Simoes 

Quick Parts are basically reusable pieces of content that you can quickly and easily drop into email messages in 
Microsoft Outlook 2016. Usually, this means blocks of text that you can insert quickly into your emails, ap-
pointments, and tasks, but it doesn’t only include text—you can also reuse tables, graphics, and document  
properties. It will also keep the formatting of the content. 
 
In this way, Quick Parts are a bit of a middle ground between email signatures and Microsoft Office templates. 
If you find yourself writing the same chunk of text into emails over and over, you’ll find Quick Parts very use-
ful. They save you time, but they also promote consistency and accuracy when sending out template emails. 
Read on to learn the basics. 

Creating Quick Parts in Outlook 2016 
Open Outlook and create a new message. This will be the quickest and easiest way to create Quick Parts for 
Outlook. Here you will be able to write out the text you want with the content and formatting it requires without 
any issues. Once you have the content created that you want as a Quick Part this is what you need to do:Select 
 
 the entire text or content, click the Insert tab. 

 

 

 

 

 

 

(Continued from page 10) 

 
(Continued on page 12) 
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Then on the right-hand side of the ribbon click Quick Parts and choose Save Selection to Quick Parts Gallery. 

 

 

This will open up the Create New Building Block dialog box. 

 

You will notice there are six options to fill in or choose: 
 

1. Name: This is self-explanatory—just give the entry a name that coincides with what it does or what it’s 
saying. 

2. Gallery: You can select different galler ies to save your  entr ies into. 
3. Category: You will mainly use this if you require a ton of Quick Par ts and entr ies. 
4. Description: You can fill this in with a quick descr iption if you’d like to but it won’t actually show up 

anywhere that makes it necessary to fill in. 
5. Save In: Keep it to NormalEmail. This way the entry can be used by all email accounts you have 

set up in Outlook. 
6. Options: Choose how you’d like the entry to be inserted into future messages or content. 
 

Inserting Quick Parts 
Now that you’ve learned how to create the Quick Parts in Outlook 2016, now you can learn how to use them so 
you can save some time when using Microsoft Outlook. 

(Continued from page 11) 

(Continued on page 13) 
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Create a new email message and place the cursor wherever you’d like to insert the entry. 
 
Now, go to the Insert tab on the ribbon, click on Quick Parts, and then select the thumbnail that matches the 
entry you’d like inserted. You can also search by typing the name of the entry. This is where using unique and  
relevant names comes in handy. 
 

 
 
And that’s all there is to it! 
 
Quick Parts in Outlook 2016 is a relatively little-known feature, but it’s one that can save you a lot of time if 
you’re sending out similar messages on a daily basis. You send out emails all day long, and using the Quick 
Parts feature will save you time and energy. 
 
 

No Personal Privacy 
 

By Matt Batt, President, The Computer Club, Inc., Florida 
December 2017 issue, The Journal of The Computer Club 
www.scccomputerclub.org 
mbatt453 (at) gmail.com 
 
I want to share (1) something to think about as we enter this time of “no personal privacy;” (2) a very useful 
program for keeping your PC applications up-to-date; and (3) a fun website for displaying street views of  
houses. 
 

1) My wife was reading a book on her Kindle and was getting close to the end. She wanted to finish the 
book, so she cloistered herself in the snug family room chair and had at it. After about half an hour, she 
finished the book and explained that it really was a great book and she really enjoyed it. A moment or 
two later, her cell phone made the noise for an incoming email and she reached over and read it. It was 
from Amazon and it asked her how she liked the book that she just finished. That was so spooky! It  

 really made us feel like our privacy had been compromised. I’m a very strong proponent of technology 
advances and all the good things that it can bring, but this just seemed like too much and too close. 
 
A couple of days later, she started another book, read a few chapters and had to put it down as things 
get busy around the first of the month. Sure enough, after a couple of days, she gets an email from  

(Continued from page 12) 

 
 
 
 

(Continued on page 14) 
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Amazon asking, “how’s it going.” Guess she wasn’t reading enough and needed to be prodded. Now, I 
don’t know what you think of that intrusion, but I find it really disturbing. Guess we’ll have to get used 
to it or take the Kindle offline. 
 

2) An important part of being safe online is keeping your computer’s software up-to-date. Outdated soft-
ware often contains security exposures that can provide hackers access to your computer. Outdated soft-
ware can also be buggy and have performance issues which are usually fixed with a newer version of the 
software. Unfortunately, if you have lots of different programs this is an onerous task. 
 
Patch My PC Updater will make patching your PC easy. It is free and keeps over 165 apps up-to-date on 
your computer. It is an easy way to update or install any of these programs on to your computer. 
 
When you open Patch My PC Updater, it will scan your system for outdated programs. It will show  
programs that are outdated in Red, programs that are updated in Green, and programs that are not  
installed in Black. With one click you can easily do all your updates. You can download Patch My PC 
from https://patchmypc.net/download. 

 
3) On a more fun note, I’ve been sharing a website called www.showmystreet.com. When you go to the 

site, you get a box where you can type in an address. It’s a simple interface that lets you display almost 
all locations. Just start typing the location’s address and the background Google Map is updated in real-
time. Like any other regular Google Map, you can drag the map, zoom in/out, and select the following 
views: map, satellite, hybrid, and terrain. Wherever available, Show My Street will automatically dis-
play the Google Street View of the address. Type the address one character at a time and watch the  
location that it displays. It’s amazing. The views can be directly shared on Twitter and Facebook. You 
can also obtain a direct URL to the view and share it with your friends online. 

 

Clean up clutter: Set up Auto Archive 
If you keep a ton of emails offline, Auto Archiving can help you save disk space by auto compressing emails 
that are beyond a certain age. You can decompress them at any time. 

1. From the main page, go to the “Folders” tab and Click on “AutoArchive Settings”.

 

2. In the box that pops up, check the “Archive this folder using these settings” radio button, choose a cutoff 
date, and choose an action to perform for old emails. 

 

(Continued from page 13) 
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PLATEAU PC USERS GROUP, Inc. 

APPLICATION FOR MEMBERSHIP 

  
           ___ New Member        ____ Renewing Member 
  

  

Return this application, with check for annual dues payable to "PLATEAU PC USERS GROUP." Return to the club 
Treasurer during our meeting or mail to PPCUG Treasurer. P.O. Box 3787, Crossville, TN 38557. Our annual dues are 
now payable on July 1st of each year.  Annual dues are $24 per single person / $30 per family starting 7/1/2014 with 
partial years’ dues as follows: 
 

 

 

Due Date Apr—Jun 2018 
Jul — Sep 2018 

Annual Dues 
Oct—Dec 2018 Jan—Mar 2019 

Single: $6 $24 $18 $12 

Families: $7 $30 $22 $15 

  

    

Date: ______________           Amount Paid: $ ____ :.00,  by Cash ___ , or    Check ( #_____________ ) 
                                                

    _____________________________________________ ________________________________  _____________________________________ 

          Last Name         First Name Family Members (if family membership) 

_______________________________________________________________________ 

           Address:  

____________________________          _____ _____________ _________________________ 

    City                        State     Zip Code Phone Number 

 
E-Mail address:  ——————————————————————- 
 

 
I have belonged to a Computer Club before. Yes    _____    No _____ _ 
 
l have used PCs since (year):   __________     
 
I have knowledge in the following areas that I would be willing to share with club members:  
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
 
Apr 2018 
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Note:  Please see page #15 for  the Plateau PC Users Group, Inc. Application for Membership form. 

June 2018 

Sun Mon Tue Wed Thu Fri Sat 

     1 2 

3 4 5 6 7 8 9 

10 11 12 6:00 P.M. 

General Mtg.  
Presentation. 
Followed By 
Q&A Session 

13  14 1:00 P.M. 

Photo Editing 
Workshop 
Club Mtg. 

15 16 

17 18 19 20 2:00 P.M. 

PPCUG Board 
Mtg. 

21 1:00 P.M. 

Plateau Pho-
tography Club 
Mtg. 

22 23 

24 25 26 27 28 29 30 


